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Ever	needed	to	modify	the	size	of	a	PDF	document?	Perhaps	you	originally	got	the	dimensions	wrong	or	need	to	alter	it	for	another	purpose.	It's	simple	to	crop	a	PDF	on	Mac,	provided	you	have	the	right	tool.	That's	where	PDFelement	comes	in	handy.	In	this	article,	we'll	demonstrate	how	to	use	PDFelement	to	crop	PDF	on	Mac.	Part	1:	How	to	Crop	a
PDF	on	Mac	PDFelement	makes	cropping	your	PDF	on	Mac	incredibly	easy.	We'll	show	you	how	it	works,	but	first,	you'll	need	to	install	PDFelement	on	your	Mac.	Once	done,	open	it	and	follow	the	simple	steps	below	to	crop	PDF	on	Mac.	Free	download	PDFelement.	In	the	main	window,	click	"Open	File"	and	browse	for	the	PDF	document	you	wish	to
crop.	Step	2:	Select	the	Area	to	Crop	Once	the	document	is	open,	click	on	the	"Tool"	tab	on	the	left	side,	then	select	the	"Crop	Pages"	option.	A	dotted	dialogue	box	will	appear	around	your	page.	Drag	the	box	to	choose	the	area	that	you	want	to	keep.	SE	###ARTICLETo	divide	documents	in	Sejda,	you	must	go	to	the	"All	Tools"	menu	and	choose	the
"Split	by	pages"	option.	Then	the	application	will	ask	you	to	upload	your	PDF.	Click	the	button	and	select	the	location	of	your	file.	Next,	you	can	select	a	Split	method.	Now	Sejda	will	show	a	few	options	to	divide	your	document.	Choose	the	one	you	like	the	most	and	click	on	"Continue."	Sejda	will	process	your	document,	and	when	it	is	ready,	a
download	button	will	appear.	Cropping	PDF	documents	on	Mac	is	extremely	easy.	Suppose	you	consider	that	performing	this	process	with	Automator	is	complicated	or	prefer	the	most	straightforward	option.	In	that	case,	you	can	use	online	services	and	achieve	professional	results	in	just	a	couple	of	seconds.	Free	Download	or	Buy	PDFelement	right
now!	You	can	crop	a	page	of	a	PDF	to	hide	content,	or	rotate	it	to	change	its	orientation.	Go	to	the	Preview	app	on	your	Mac.	Open	the	PDF	you	want	to	crop,	click	(if	the	Markup	toolbar	isn’t	showing),	then	click	.	Select	the	portion	of	the	page	you	want	to	keep.	If	you	want	to	view	the	dimensions	of	the	content	you’re	selecting,	choose	Tools	>	Show
Inspector,	then	click	and	choose	a	unit	of	measurement.	Click	in	the	Markup	toolbar.	Note:	To	undo	the	crop	immediately,	choose	Edit	>	Undo	Crop.	To	undo	the	crop	later,	find	a	version	of	the	file	before	the	crop.	Choose	File	>	Revert	To	>	Browse	All	Versions,	then	find	the	one	you	want.	To	rotate	one	page:	Click	to	rotate	the	page	to	the	left.
Continue	clicking	to	keep	rotating.	To	rotate	a	page	to	the	right,	press	and	hold	the	Option	key	and	click	until	you’re	done	rotating	the	page.	Rotate	several	pages	at	once:	Choose	View	>	Thumbnails	or	View	>	Contact	Sheet,	select	the	pages	to	rotate,	then	click	to	rotate	the	pages	to	the	left.	To	rotate	the	selected	pages	to	the	right,	press	and	hold
the	Option	key	and	click	until	you’re	done	rotating	the	pages.	It's	easy	to	crop	a	PDF	on	a	Mac	computer	in	just	a	few	steps.	Crystal	Cox/Business	Insider	This	story	is	available	exclusively	to	Business	Insider	subscribers.	Become	an	Insider	and	start	reading	now.	You	can	crop	a	PDF	document	on	your	Mac	computer	using	the	Preview	app.	When	you
crop	a	PDF	with	multiple	pages,	it	will	only	affect	the	particular	page	you're	on	in	Preview	—	you'd	have	to	make	the	crop	on	each	page	individually.	A	PDF	is	one	of	the	most	useful	file	formats	because	it	is	so	universally	accessible.	No	matter	what	operating	system	you	are	using,	from	Windows	to	Mac	OS,	PDF	documents	should	always	look	the	same
and	won't	be	altered	or	corrupted	when	shared.	But	while	you	might	think	of	PDFs	as	locked	and	unalterable,	in	fact	you	are	able	to	edit	them.	If	you	use	a	Mac	computer,	cropping	a	PDF	to	remove	unwanted	content	is	quick	and	easy.	Here's	how	to	do	it.	Check	out	the	products	mentioned	in	this	article:	Macbook	Pro	(From	$1,299	at	Best	Buy)To
learn	how	to	crop	a	PDF	on	Mac,	it's	like	cutting	out	a	piece	of	paper	from	a	bigger	sheet	-	you	want	to	isolate	the	important	part	and	discard	the	rest.	There	are	several	ways	to	do	this,	but	we'll	focus	on	two	popular	methods:	using	online	tools	like	PDF	Candy	or	Adobe	Acrobat.	When	working	with	PDFs	on	your	MacBook	or	iMac,	it's	not	uncommon
to	need	to	crop	them	down	to	size.	This	could	be	for	a	variety	of	reasons	-	maybe	you	only	want	to	use	a	specific	image	from	the	document,	or	perhaps	you	need	to	adjust	the	margins	to	fit	your	project.	In	this	article,	we'll	explore	how	to	crop	a	PDF	on	Mac	using	these	two	methods.	**Method	1:	Using	PDF	Candy**	PDF	Candy	is	a	free	online	tool	that
lets	you	crop	your	PDF	files	with	ease.	It's	like	having	a	virtual	pair	of	scissors	at	your	fingertips!	To	get	started:	1.	Open	the	PDF	Candy	website	in	any	browser	on	your	Mac.	2.	Click	the	"+	Add	file"	button	or	drag	and	drop	your	PDF	into	the	working	area.	3.	Use	the	dots	to	adjust	the	cropping	area	on	both	horizontal	and	vertical	lines.	4.	Once	happy
with	your	selection,	hit	the	"Crop	PDF"	button.	**Method	2:	Using	Adobe	Acrobat**	If	you	have	an	Adobe	account,	you	can	use	their	cropping	tool	to	adjust	your	PDFs.	Here's	how:	1.	Go	to	the	Adobe	website	and	select	the	cropping	tool.	2.	Click	the	"Select	a	file"	button	to	upload	your	PDF.	3.	If	prompted,	create	an	account	or	sign	in	if	you	already
have	one.	Regardless	of	which	method	you	choose,	remember	that	cropping	will	be	applied	to	all	pages	of	the	document.	To	save	your	cropped	PDF,	click	"Download	file"	or	explore	other	editing	options	like	compressing,	rearranging	pages,	merging	files,	and	adding	watermarks.	By	mastering	these	techniques,	you'll	become	proficient	in	working	with
PDFs	on	your	Mac	-	a	valuable	skill	for	anyone	who	frequently	uses	this	format.	With	online	tools	like	PDF	Candy	and	Adobe	Acrobat,	cropping	a	PDF	is	now	easier	than	ever!	Cropping	PDFs	can	be	accomplished	using	various	methods	and	tools,	each	with	its	own	set	of	benefits	and	drawbacks.	Using	Adobe	Acrobat	allows	for	more	flexibility	and
advanced	features	such	as	converting	PDF	to	Word	or	other	formats,	compressing	files,	and	more.	However,	cropping	a	PDF	in	this	software	requires	an	upgraded	account	which	may	not	be	worth	the	investment	for	everyone.	Those	who	prefer	using	desktop	software	can	take	advantage	of	the	built-in	PDF	cropping	tool	in	Mac	computers'	Preview
app.	However,	it	has	limitations	such	as	only	being	able	to	crop	one	page	at	a	time	and	saving	all	changes	automatically.	Another	option	is	to	use	third-party	apps	like	PDFsam	Visual	which	provides	more	flexibility	and	advanced	options	such	as	extracting	images	from	a	PDF	or	rotating	pages	of	the	document.	This	software	requires	paid	access	but
offers	a	14-day	trial	for	free	cropping.	Cropping	PDFs	online	has	its	conveniences,	being	quick	and	easy	with	no	need	to	install	any	software	on	your	device.	Many	platforms	offer	free	accounts	with	basic	features	while	premium	versions	provide	additional	instruments.	Shareability	is	also	a	key	advantage	as	you	can	easily	share	the	cropped	PDF
directly	from	the	website	via	a	link	or	cloud	storage	services.	On	the	other	hand,	offline	programs	like	PDFsam	Visual	have	more	efficiency	and	security	benefits,	allowing	for	quick	editing	without	waiting	for	an	online	tool	to	process	the	document	and	keeping	your	documents	secure	on	your	computer.	However,	they	may	require	more	time	and	effort
as	you	need	to	install	the	software	and	retrieve	the	files	later.	In	conclusion,	both	online	and	offline	methods	of	cropping	PDFs	provide	users	with	extensive	sets	of	instruments	for	editing	and	manipulating	their	documents.	Ultimately,	the	choice	between	these	options	depends	on	individual	needs	and	preferences.	Cropping	PDFs	on	Mac	Made	Easy
##	Step	1:	Choose	Your	Tool	To	crop	a	PDF	on	your	Mac,	you	can	use	the	built-in	Preview	application	or	third-party	software	like	Adobe	Acrobat.	If	you're	looking	for	an	easy	and	free	option,	try	using	Smallpdf.	##	Step	2:	Open	Your	PDF	in	Preview	Open	your	PDF	file	in	the	Preview	app	on	your	Mac.	###ARTICLELooking	forward	to	seein	everyone
at	the	meeting	tomorow	and	discussin	our	strategies	in	detail.	The	main	reasons	why	people	may	need	to	crop	a	PDF	document	are	to	resize	it	for	printing,	re-orient	it	for	use	in	presentations,	or	get	elements	to	the	right	size.	Cropping	can	help	remove	confidential	information	from	shared	documents.	It	is	also	a	good	way	to	highlight	important
aspects	of	a	document.	You	can	divide	a	merged	paged	file	into	smaller	files	for	easier	sharing.	Additionally,	cropping	can	be	used	to	remove	unwanted	content	from	a	PDF.	If	you're	looking	for	a	more	professional	solution,	consider	dedicated	PDF	software	such	as	Offline	Adobe	Acrobat,	online	Smallpdf,	or	PDF	Expert.	However,	if	all	you	need	is
minor	text	editing	in	a	PDF,	there	are	cost-effective	options	like	UPDF	for	Mac	available.	One	of	the	main	reasons	why	you	may	need	to	crop	a	PDF	document	is	to	resize	it	for	printing.	This	can	help	get	the	margins	just	right	for	the	intended	printing	paper.	Cropping	tools	can	also	be	used	to	re-orient	a	document,	depending	on	its	intended	use.	For
example,	you	can	use	them	to	rotate	a	PDF	into	a	vertical	orientation	or	a	landscape	layout	ideal	for	PowerPoint	presentations.	To	crop	a	PDF	page	on	Mac,	open	it	first	and	click	the	"Crop	Pages"	icon	on	the	left	toolbar.	This	will	reveal	the	tools	to	crop	PDF	pages.	You	can	drag	the	eight	purple	angles	to	adjust	the	area	you	want	to	crop.	You	can	also
set	the	margin	and	page	size	using	the	options	icon.	Cropping	a	PDF	Document	with	Ease:	A	Guide	for	Mac	Users	If	half	of	your	work	involves	editing	or	sharing	PDF	documents,	you	can	use	the	cropping	function	of	UPDF	to	perform	the	process.	It	helps	you	easily	define	the	margins	and	cut	out	documents	according	to	your	requirements.	Cropping	a
PDF	document	on	Mac	can	be	one	of	the	most	difficult	edit	tasks	to	make,	especially	when	you	don't	have	the	right	tool	to	do	it.	If	you	work	with	many	PDF	documents,	you	may	be	in	need	of	a	more	versatile	solution	like	UPDF.	With	it,	you	can	create	PDFs	and	make	changes	to	all	the	content	on	them,	as	you	would	on	a	Word	Processor.	It	is	also	so
easy	to	use,	there	is	no	learning	curve	even	for	beginners.	Windows	•	macOS	•	iOS	•	Android	100%	secure	PDF	files	are	one	of	the	safest	and	easiest	ways	to	share	information	and	documents.	They	are	accessible	on	almost	any	device,	no	matter	if	you	are	on	Mac,	Windows,	iOS,	or	Android.	While	viewing	a	PDF	document	on	any	device	is	easy,
knowing	how	to	edit	a	PDF	can	be	tricky.	What	if	you	want	to	share	a	small	portion	of	the	page	with	someone	or	cut	out	private	information	before	sharing	the	file?	You’ll	need	an	easy	way	to	crop,	edit,	and	save	the	file.	Unfortunately,	it	can	be	confusing	for	new	users	to	crop	PDF	documents.	The	standard	PDF	viewer	on	Mac	devices	does	not	offer	a
way	to	easily	crop	a	PDF	file.	Luckily,	there	are	many	free	PDF	editor	options	available	to	crop	a	PDF	on	Mac.	Our	guide	below	will	show	you	how	to	edit	a	PDF	on	Mac	for	free.	What	is	a	PDF?	If	you’re	an	experienced	computer	pro,	you’ve	probably	seen	thousands	of	PDFs.	If	not,	here’s	a	quick	overview	of	PDF	files.	Adobe	PDF	is	one	of	the	most
commonly	used	file	types.	Portable	Document	File	(PDF)	is	a	file	type	that	makes	viewing	a	file	easy	on	all	types	of	devices.	It	is	recognized	by	the	International	Organization	for	Standardization	(ISO)	as	an	open	standard	for	file	types.	This	standard	allows	PDF	files	to	be	shared	independent	of	hardware	and	software	standards.	Clicking	on	a	PDF	file
will	open	the	file	inside	a	web	browser	window.	It	doesn’t	require	additional	software	installed	on	a	device	for	viewing.	This	makes	a	PDF	extremely	versatile.	Whether	you	are	on	a	Mac	laptop	or	an	Android	smartphone,	anyone	with	a	web	browser	can	open	and	view	a	PDF.	PDF	files	can	contain	images,	text,	links,	forms,	scanned	hardcopy,	legal
documents,	audio,	video,	and	more.	They	offer	built-in	accessibility	for	people	with	disabilities,	are	ideal	for	printing,	and	can	be	used	as	interactive	forms.	While	viewing	a	PDF	in	a	browser	window	is	simple,	it	doesn’t	give	you	many	options	to	edit	the	file.	If	you	want	to	make	edits	to	a	PDF	file,	you’ll	need	access	to	editing	software.	Luckily,	many
online	PDF	editing	options	make	it	easy	to	crop	and	edit	any	PDF	file.	Do	you	need	to	crop	a	PDF?	A	PDF	document	can	be	almost	anything.	From	a	simple	picture	to	a	private	contract,	PDF	files	are	used	to	share	information	easily	across	platforms.	What	if	you	have	a	file	that	needs	sharing,	but	you	don’t	want	to	share	the	entire	file?	This	is	where	a
PDF	editor	will	help.	Here	are	some	reasons	you	may	need	to	crop	a	PDF	file.	Remove	private	or	confidential	information	from	a	PDF	document.	Highlight	key	information	from	a	file.	Divide	the	PDF	file	into	smaller	and	easier-to-understand	portions.	Remove	or	Merge	Pages	of	a	PDF	file.	Share	part	of	a	PDF	with	employees.	Cropping	a	PDF	on	Mac
Whether	you	are	an	expert	or	new	to	Mac,	you	have	several	options	available	to	crop	a	PDF.	From	native	applications	to	online	editors,	your	Mac	has	many	ways	to	crop	PDF	pages.	Below	we’ve	highlighted	some	of	the	easiest	and	most	effective	ways	to	crop	a	pdf	file	on	Mac.	How	to	Crop	a	PDF	on	Mac	with	Preview	Alternatively,	your	Mac	has	a	few
other	cropping	options	for	PDF	files.	Preview	is	a	free	tool	on	Mac	that	can	also	make	cropping	a	PDF	easier.	If	you	are	looking	for	a	native	tool	to	crop	PDF	files,	Preview	is	your	best	bet.	Below	are	two	simple	methods	that	show	you	how	to	crop	a	PDF	on	Mac	with	Preview.	Method	1	Open	the	PDF	in	Preview.	Find	“Tools”	in	the	toolbar	and	choose
“Rectangular	Selection”	from	the	dropdown.	Use	the	Drag	tool,	starting	from	the	top	left.	to	draw	the	area	that	needs	cropping.	Select	“Crop”	from	the	“Tools”	menu.	Your	file	will	now	be	cropped	and	can	be	saved	to	your	Mac.	Method	2	Open	the	PDF	in	Preview	Click	on	“Show	Markup	toolbar”	to	add	the	toolbar	to	Preview.	Use	the	“Rectangular
Selection”	icon	to	start	the	cropping	process.	Use	the	Drag	tool,	starting	from	the	top	left.	to	draw	the	area	that	needs	cropping.	Click	the	“Crop”	icon	to	crop	the	image.	Your	new	file	is	ready	to	be	saved	on	your	Mac.	Use	Screenshot	to	Crop	a	PDF	While	it	might	not	offer	versatility	or	editing	features,	the	screenshot	tool	can	be	used	to	quickly	crop
any	PDF	on	Mac.	Open	the	file	in	Preview	or	a	web	browser.	Users	on	macOS	Mojave	and	later	have	to	press	Shift-Command-5	to	take	the	screenshot.	All	other	macOS	users	need	to	press	Shift-Command-4	to	take	a	screenshot.	Open	the	newly	created	PNG	image	in	Preview.	Select	File>Export	as	PDF	and	save	the	cropped	image	as	a	PDF.	Using
Adobe	Acrobat	to	Crop	a	PDF	Do	you	have	an	Adobe	subscription?	If	you	have	a	personal	or	work	computer	with	Adobe	Acrobat	DC,	you	can	easily	crop	PDF	pages	and	documents.	Here	are	instructions	on	how	to	crop	a	PDF	in	Adobe	Acrobat.	Open	the	file	in	Adobe	Acrobat.	From	the	“Tools”	menu	select	“Edit	PDF.”	Choose	“Crop	Pages”	from	the
toolbar.	Use	the	rectangle	tool	to	draw	an	area	that	will	be	cropped.	Double-click	inside	the	rectangle.	Click	“OK	to	crop	the	page.	Save	the	file	to	your	Mac.	Benefits	of	a	using	a	free	PDF	editor	to	crop	a	PDF	As	you	can	see,	cropping	a	PDF	is	easy	and	straightforward	on	a	Mac.	What	if	you	want	more	control	over	your	files?Editing	text	of	scanned
PDFs	can	be	made	easier	with	the	help	of	a	free	PDF	editor,	which	offers	more	control	over	your	files	than	the	Mac's	native	Preview	tool.	If	you	need	extensive	editing	control	over	a	PDF	file,	tools	like	Sizle	give	you	total	control	over	your	file.	You	can	change	font	size	and	color,	crop	and	color	images,	add	comments	and	annotations	to	your	PDF,
rotate	and	resize	documents,	convert	other	document	types	to	PDF,	and	convert	PDF	to	Word,	Excel,	JPG,	and	many	other	formats.	Editing	scanned	hardcopy	into	a	PDF	is	also	possible	with	online	PDF	editors	like	Sizle.	You	can	easily	edit	scanned	and	hardcopy	images	and	add	signatures	to	documents.	Highlighting	content,	strikethrough,	or
underlining	are	some	of	the	features	that	allow	you	to	personalize	your	PDFs	further.	You	can	fill	out	and	save	forms	in	PDF	format	as	well.	Splitting	and	merging	PDF	documents	is	also	a	useful	feature	for	organizing	files.	To	safely	share	PDFs,	online	PDF	editors	often	offer	an	easy	and	secure	way	to	share	files	with	team	members	or	customers.	This
helps	track	who	viewed	or	edited	your	file	and	allows	you	to	manage	workflow	efficiently.	With	no	compatibility	issues	when	using	online	PDF	editors,	users	can	edit	on	their	Mac	and	send	the	work	to	others	using	Windows,	Linux,	iOS,	or	Android	devices.	With	our	editor,	you	have	the	power	to	control	every	aspect	of	your	PDF	files,	from	fonts	and
colors	to	images	and	annotations.	You	can	crop	and	color	images,	add	comments	and	notes,	rotate	and	resize	pages,	convert	document	types,	edit	scanned	and	hardcopy	images,	and	even	add	signatures.	Our	editing	capabilities	also	allow	you	to	highlight,	strikethrough,	or	underline	content,	fill	out	and	save	forms,	split	and	merge	PDF	documents,	and
search	for	text	within	multiple	PDFs.	The	best	part?	No	software	needs	to	be	downloaded,	and	our	online	editor	provides	seamless	sharing	abilities	that	make	collaborating	on	files	a	breeze.	Whether	you're	using	a	Mac	or	any	other	operating	system,	including	Windows,	Linux,	iOS,	or	Android,	our	online	PDF	editor	gives	you	total	control	over	your
PDF	file	without	requiring	any	setup.	With	our	trusted	tool,	you	can	edit,	annotate,	and	share	PDFs	with	ease,	securing	leads	and	analytics	as	you	go.	We've	helped	29,000+	professionals	achieve	their	goals	with	our	simple,	fast,	and	free	methods.
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